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Documentation Style Guide

TL;DR

Writing Guidelines

COMPanion’s voice is human. It’s familiar, friendly, and straightforward. Our priority is explaining our products and helping our users get their work done so 
they can get on with their lives. We want to educate people without patronizing or confusing them.

Accuracy. Our first and foremost concern is that we present the correct information in a truthful way.
Clarity. We try to avoid legal jargon and overly formal wording. Our users need to understand the agreement they’re making with us.
Succinctness. We want our users to read and understand our documentation, while also respecting their time.

Technical content talks to users when support agents can’t. We write and edit this content based on these goals:

Content principles

Start with user needs
Write in a way that suits the situation. Ask yourself: Who is going to read this? What do they need to know? How might they be feeling?
Help people find the information they need quickly and easily. Guide them through the process.

Do the hard work to make it simple

Use plain language and simple sentences.
Choose clarity over cleverness.
Stay conversational, using contractions when appropriate.
Keep headlines and paragraphs short and easy to scan.

Write for everyone

Respect the complexity of our users’ experiences.
Be willing to be surprised about who’s reading your work.

Build trust

Talk like a person.
Tell the truth.
Use positive language and concrete examples.

Be consistent

Use the labels and terminology used by COMPanion.
Use specific, active verbs for certain tasks.
Choose basic words and phrases to facilitate consistency across translated content.

Start small and iterate

Make sure your content works for users. Don’t be afraid to scrap what’s there and start over.
Write a draft, test it out, gather feedback, and keep refining.

Organization

All relevant information on this page has been moved to our .Documentation Stylebook

As you write, consider the following:

Will this language make sense to someone who doesn’t work here?
Can someone quickly scan this document and understand the material?
If someone cannot see the colors, images or video, is the message still clear?
Is the markup clean and structured?
Mobile devices with accessibility features are increasingly becoming core communication tools. Does this work well on them?

https://docs.google.com/document/d/1E62rvxe2DjSzxOtJISdT9lD_gbkurISkW9-ReCnWW2M/edit


Organization
Confluence is organized the way the program is organized. The primary modules are listed in the menu at the top: Circulation, Items, Patrons, Tools, 
Researcher, and Support. Each module has a landing page that directs users to content for that module. Some landing pages have Image Maps, like P

, , and  . atrons Tools Preferences

We use Brikit Theme Press to design the Support Center. Read through the   to learn how it works with Confluence. You will refer Brikit documentation
to it often.

Key Action

. Opens the Theme Press menu

z Opens or hides the Confluence sidebar and header. 

Spaces

Content is divided by space, and each space has a theme (style) and menu. 

Space Theme Menu

Alexandria Alexandria Alexandria

Alexandria Library Alex ALIB

COMPanion COMPanion COMPanion

KeepnTrack KnT KeepnTrack

KeepnTrack Library KnT KeepnTrack

Textbook Tracker TextbookTracker Textbooks

Textbook Tracker Library TextbookTracker Textbooks

Testing Testing Alexandria

I use the Testing space to test new layouts, theme changes, or anything else I don't want to be public quite yet. The Testing  is one I was theme
playing with to match the header and footer with the redesign and make the background less of a strain on my eyes. 

Page Titles

Pages are named after the module or section they belong to. 

No two pages can have the same title. This usually isn't a problem, but it can be. For example: 

Circulation > The module landing page
Circulation > The first tab in the Circulation module. 
Circulation > Preferences

Preferences is a particular problem. Because nearly every preference is named after a module, each page includes "Preferences" in the title. 

Circulation Preferences
Patron Preferences
Security Preferences

Duplicate Pages

One page cannot be included in two page trees, but some of them should be. For example, as a customer, I would expect to see information about 
Patron Preferences in the Patrons section.

To keep some related content together, the original page was copied and a space was added to the title so that page could be include in the other 
page tree. The copied page uses the  macro to pull content from the original page, so there's still only one place to edit the content. Include Content

For example: 

All relevant information on this page has been moved to . https://support.goalexandria.com/style-guide/

http://support.companioncorp.com/display/ALEX/Patrons
http://support.companioncorp.com/display/ALEX/Patrons
http://support.companioncorp.com/display/ALEX/Tools
http://support.companioncorp.com/display/ALEX/Preferences
http://www.brikit.com/display/documentation/Home
http://support.companioncorp.com/display/ALEX
http://support.companioncorp.com/display/ALIB
http://support.companioncorp.com/display/COMP
http://support.companioncorp.com/display/KnT
http://support.companioncorp.com/display/KLIB
http://support.companioncorp.com/display/TT
http://support.companioncorp.com/display/TLIB
http://support.companioncorp.com/display/TEST/Testing+Home
http://www.brikit.com/display/documentation/Include+Content+Macro
https://support.goalexandria.com/style-guide/


1.  
2.  
3.  
4.  

Tools > Preferences > Patron http://support.companioncorp.com/display/ALEX/Patron+Preferences

Patrons (duplicate) ttp://support.companioncorp.com/display/ALEX/Patron++Preferences

Most of the time, this kind of duplication isn't necessary. I don't love this solution, but I felt it was important to make certain content more accessible. 

Page Layouts

Alexandria is a complicated program, and some of the content is nested deep in the page tree. When you open a page, the Table of Contents on the 
left will highlight the page you're on and where it is in the page tree; however, it doesn't expand the tree to show content nested under that page, 
which means content can easily be missed. 

To solve this problem, we use Page Layouts. Each module has a specific  that contains a Table of Contents and title header specific to Page Layout
that module or section. For example, the  page shows all of the Reports subpages on the left, instead of the entire page tree. Breadcrumbs at Reports
the top of the Contents section will show you where you are in relation to the rest of the Support Center.

KeepnTrack and Textbook Tracker have only one Page Layout that shows the same Table of Contents for the whole program. This isn't as big of a 
deal because these apps are a lot smaller than Alexandria and content is less likely to be lost or missed.

Make sure to set the appropriate Page Layout after creating a new page. 

Type . (period) to open the designer. 
In the Page tab, click . Page Design
If it's set to Use Space Default, click .Override Design
Select the correct layout for the content. 

You can view each Page Layout in the . Any changes you make there will affect all of the pages using that layout, so be Theme Press Architect pages
careful.

Problems

Confluence is not perfect! You'll find there are a lot of inconsistencies and weird things going on in each Support Center. 

The search box is missing

Brikit has a setting to add the search box to the Brikit header, but confluence made some changes and now it doesn't work. It should be fixed in Brikit 
Theme Press 2.4. 

https://support.brikit.com/browse/PRESS-2444 
https://support.brikit.com/browse/PRESS-2446

Mobile view

It doesn't work well. You can view it on a mobile device, but any page with columns will be pretty messed up.

PDF / Printing view

It doesn't work well. You CAN DO IT but any page with columns will be squashed.

Circulation Tabs

This section is messy. In the app, some of the Circulation tabs have subtabs. Confluence doesn't do subtabs . . . To get around that, for each tab I set 
up a page with tabs for the subabs. Yep, it's confusing. The Circulation Tabs page is set up like the app, with the appropriate tabs, and content is 
"included" from the primary subpage. But tabbed content is listed on top of the other, which means the page is long and hard to read. Feel free to find 
a better way. Please. Please find a better way. 

Circulation Tabs
Circulation tab: Transaction Log, Renewals, Homeroom
Holds tab: Patron, Item
Charges tab: Charges, History

Feel free to find a better way. Please find a better way. 

Other to-dos

Landing pages : try to fix - search bar - text color + highlight color ... can't figure out how to edit (might need custom code)
-also random 2 underscores at the 'header' of the support pages
Note There is custom code for search functions (from Brikit) - like the space-specific function -

Reports - 
RUIE documentation issues draft for the project with Stephanie
patron barcode labels 3x10 draft for start of report pages

Later someone to-do:

http://support.companioncorp.com/display/ALEX/Patron+Preferences
http://support.companioncorp.com/display/ALEX/Patron++Preferences
http://www.brikit.com/display/documentation/Page+Layouts
http://support.companioncorp.com/display/ALEX/Reports
http://support.companioncorp.com/display/themepressdefault/.brikit
https://support.brikit.com/browse/PRESS-2444
https://support.brikit.com/browse/PRESS-2446
http://support.companioncorp.com/display/ALEX/Circulation+Tabs


alexandria library space - clean up and add labels
look at the advance tables macro for new possibilities
courses, quizzes -- add-ons trials... remove or buy them

Editor Pages (Hidden) 

On the bottom left, go to > . This is where you can see and reorganize pages in the various page trees. All customer Space Tools  Reorder pages
documentation is listed under the Support tree.

At the top, click  . This is where I keep all of my drafts, notes, and content that customers don't need to see. The primary page Editor Pages (Hidden)
and, subsequently, its child pages are locked so confluence-administrators and confluence-users who are logged in can view and edit the content. 

Ignore the How To pages. I was planning on using the instructions as excerpts, but I don't think we ever got around to it. These are likely old and just 
need to be deleted, but I didn't have time to check for sure. 

Archived Versions are old versions of articles for historical purposes. When I have to completely rewrite a page, I'll often copy the original page 
(Toolbar ... menu > Copy) and move it to my drafts. When it's done, I move the original to this archive, and move the new one to the right spot in the 
page tree. If you choose to do the same, make sure you rename the articles correctly, so the new one has the same title as the old one, and the old 
one indicates it's old or archived. 

Links
Bookmark these:

Support Portal http://support.companioncorp.com/

Alexandria v6 http://www.companioncorp.com/mediawiki/index.php/Main_Page

Alexandria v7 http://support.companioncorp.com/display/ALEX/Support

KeepnTrack http://support.companioncorp.com/display/KnT/Support

Textbook Tracker v4 http://www.companioncorp.com/mediawiki/index.php/Textbook_Tracker

Textbook Tracker v7 http://support.companioncorp.com/display/TT

Important Links

Confluence Admin Console Manage the Confluence Server settings. 

Confluence Architect Manage all of the page layouts, menus, headers, and footers used in Theme Press. 

Theme Press Demo See how it works

Brikit Support You'll need a login

Confluence Marketplace Find apps for Confluence Server and Cloud. 

Confluence Server docs Learn how to use Confluence.

Shortcut Action

. Opens the Theme Press menu

z Opens or hides the Confluence sidebar and header. 

Library

Library Spaces
All images, videos, excerpts, and other content are stored in the inclusion library and then reused in various places in the Support Center. 

Each brand has an inclusion library, and each library has most of the same pages.

this info is obsoleted as we move to wordpress

http://support.companioncorp.com/display/COMP/Support
http://www.companioncorp.com/mediawiki/index.php/Main_Page
http://support.companioncorp.com/display/ALEX/Support
http://support.companioncorp.com/display/KnT/Support
http://www.companioncorp.com/mediawiki/index.php/Textbook_Tracker
http://support.companioncorp.com/display/TT
http://support.companioncorp.com/admin/console.action
http://support.companioncorp.com/display/themepressdefault/.brikit
http://support.companioncorp.com/display/themepressdefault/.brikit
https://support.brikit.com/secure/Dashboard.jspa
https://marketplace.atlassian.com/addons/app/confluence
https://confluence.atlassian.com/doc/confluence-server-documentation-135922.html


1.  
2.  

Space Link

Alexandria Library http://support.companioncorp.com/display/ALIB/

KeepnTrack Library http://support.companioncorp.com/display/KLIB/

Textbook Tracker Library http://support.companioncorp.com/display/TLIB/

Naming Schemes

Images are named to keep them organized by type and location so you can actually search for and find a specific image when inserting one into a 
Confluence page. And when the app UI is updated and you need to update an image, instead of going to each page the image might be on, just get a 
new screenshot, give it the same title and extension of the old one, and upload that to the library. The image will be updated everywhere it's included. 

The icnlud

Brand Type Module Location Secondary_Location

Use a space between each term and an underscore between a term with two or more terms. 
Hyphens are only used if the term itself is hyphenated, such as Self-Service. 

For example: Alex S Tools Preferences Extras Clever

Brand Type Module Location Secondary 
Location

Alex
KnT
TT

G - Graphic
S - Screenshot
V - Video

Tools
Preferences
Circulation
etc.

For example:

Alex S Tools Preferences Extras Clever

Icons & Graphics

Name format: Alex G Module Specifics

PDFs

Name format: (for reports, this is usually the output name of the pdf)

Example Reports (PDFs)

Images

This is primarily screenshots of the Alexandria program, though some images may be for other things.

Name format: Alex S Module Location Specifics

All library page titles should start with Alex.

Videos

The Videos library page has all of the library videos organized into sections.

All multi-excerpts should be centered.
All multi-excerpt titles should include the video ID (if applicable—we don't use these much anymore) and title.
All multi-excerpts should be formatted with the title in H3 and the info icon next to it with a hover tooltip that includes the last updated date 
and the version it applies to – no punctuation.

Insert Images

Command + M, or go to + and choose .Files and Images

http://support.companioncorp.com/display/ALIB/
http://support.companioncorp.com/display/TLIB/
http://support.companioncorp.com/display/TLIB/
http://support.companioncorp.com/pages/viewpage.action?pageId=17597635


2.  
3.  

a.  

b.  

c.  
d.  

4.  
a.  

Search on other pages.
Enter your search term(s). 

For best results, enter search terms that match the file name format. First enter the brand (Alex, TT, KNT), type (S for screenshot, G 
for graphics), module, and location. For example, Alex S Items will return all Alexandria screenshots from the Items module. The 
more specific you are, the fewer your results, and the easier it will be to find that specific image.
If searching multiple terms, they must be in the same order as the file name. For example, searching for "Notes Items" will return 
different results than "Items Notes."
If you're looking for 
I 

Scan the results to find the image you're looking for. 
The search results include an image thumbnail, the image title, and the page on which the image is located. 

Macros

Documentation

Confluence Macros
Brikit Macros

Specific Macros

Macro 
Documentation

Use

Redirect Redirect one page to another. Useful when you need to change a page title but the old page title is linked to from other sources or was likely 
bookmarked. 

Advanced 
Tables

They recently updated this addon and I haven't spent a lot of time playing with it. Read through the documentation — there's a lot you can do 
with it. We do use these tables to display attachments in the inclusion libraries.

Include 
Content

Use this one to duplicate a block of content from one page or space to another, like including Alexandria content in Textbook Tracker. 

MultiExcerpt Select multiple excerpts to copy across pages and spaces then recombine them to aggregate to display your content how you want

Image Mapping There are two macros–the Image Map Macro and Image Map Area Macro–that work together to create an image with elements within it that 
link to other pages. This is what you'll use to make  . You can either have a map with one image and multiple clickable areas, Alex Image Maps
or you can have a more interactive map that changes as you hover over various elements to reflect what the program does. 

Use  to map the selection/link area, then do a little bit of math to get the hotspot coordinates: > Filters > Web > ...GIMP ImageMap

Add x1 and x2: 7 + 41 = 48
Add y1 and y2: 21 + 17 = 38

GIMP 7 21 41 17

ImageMap 7 21 48 38

Image Maps take a long time and they're easy to screw up. The images you use must be the same size!!

Mechanics

Text Formatting

Left-align text, never center or right-aligned.
Leave one space between sentences. Never two. Or three. And four is just out of the question. Don’t even.

this page is obsoleted as we move to wordpress

To  a page which  instantly, add '? =false' to the URL manually.edit redirects redirect

All relevant information on this page has been moved to our .Documentation Stylebook

https://confluence.atlassian.com/doc/macros-139387.html
http://www.brikit.com/display/documentation/Macro+Reference+Guide
https://docs.servicerocket.com/redirection/user-guide/using-the-redirect-macro-to-redirect-pages
https://bobswift.atlassian.net/wiki/spaces/TBL/pages/45809669/Attachment+Table+Macro
https://bobswift.atlassian.net/wiki/spaces/TBL/pages/45809669/Attachment+Table+Macro
http://www.brikit.com/display/documentation/Include+Content+Macro
http://www.brikit.com/display/documentation/Include+Content+Macro
https://artemis.atlassian.net/wiki/spaces/SUP/pages/410845659/MultiExcerpt+Server+-+User+Guide
http://www.brikit.com/display/documentation/Image+Mapping+Macros
http://support.companioncorp.com/display/ALIB/Alex+Image+Maps
https://www.gimp.org/
https://docs.gimp.org/en/plug-in-imagemap.html
https://docs.google.com/document/d/1E62rvxe2DjSzxOtJISdT9lD_gbkurISkW9-ReCnWW2M/edit
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3.  

1.  
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Don’t use underline formatting, and don’t use any combination of italic, bold, caps, and underline.

Bold

Use bold when referencing in-app element, button and navigation labels customers will click on or interact with:

Example: 

Click the Accounts menu at the top of the page.
Click Passwords in the submenu.
Scroll down to Two-Factor Authentication, and then click the Enable Two-Factor Authentication link.

To add a repository:

Go to Admin >  Repository List > Add repository.
Select a Repository type from the dropdown menu.
Specific fields will appear on the  screen, depending on the chosen repository type. Enter the repository details as prompted. Add Repository
You will find more information in the specific sections listed below.

Capitalization

Page Titles & Headings: Capitalize the first letter of the first and last words. Capitalize the first letter of all words in between, with the 
exception of articles (a, an, and the); coordinating conjunctions (and, but, for, nor, or, so, and yet); and prepositions of four letters or fewer 
(at, for, with, into, etc.).

Use proper capitalization for proper nouns, including the names of COMPanion products, features, pages, tools, and team names, when 
referred to directly. In step-by-step instructions, capitalize navigation, field, and button labels as they appear in the app.

COMPanion, Alexandria, Textbook Tracker, KeepnTrack
Circulation, Circulation Management
Tools

Go to Tools and select Preferences. 
Export is a tool to...

Do not capitalize common nouns that simply describe the product or feature, even when it's also the proper name of a module. 
In the  report, you can choose to include records with a specific policy, like Fiction or Non-Fiction.Title Information

Do not capitalize for emphasis.

Do not capitalize random words in the middle of sentences. Here are some words that we never capitalize in a sentence:

website
internet
online
email

Hyphens

Use hyphens to create compound words.

Be consistent with which words you hyphenate.

A prefix carries a hyphen if the second element is a capitalized word or numeral (un-American, pre-1914).

Hyphenate if the compound is a homonym (re-create means to create again, recreate means to take recreation).

Use an en dash (–) instead of a hyphen to indicate ranges, such as 1991–2010.

Italics

Use italics for emphasis, but don't overdo it.

Use italics for specific references to the titles of guides, reports, imports, exports, utilities.

Avoid using italics in on-screen text; it's hard to read.

Punctuation

Ampersands

Try to avoid using them, but they’re okay if space is a major concern.

Apostrophes

Its is possessive. Each template has its own title.



It’s is a contraction for it is. It’s going to launch on Friday.
Never use an apostrophe on plural acronyms. Most ISPs use spam checkers.

Commas

Love that Oxford Comma! Put a comma before the last item in a series: Email, surveys, and events. Otherwise, use common sense. If you’re 
unsure, read the sentence out loud. Where you find yourself taking a breath, use a comma. (See what I did there?)

Ellipses

The most common use for ellipses in UI copy is to add a sense of suspense.  Use them sparingly. Don’t use them for emphasis or drama, 
and don’t use them in titles or headers.

Exclamation points

These show you’re really psyched about something, so only use them if you’re bouncing off the walls with excitement. Which you shouldn’t 
be all the time.

Never use more than one at a time. They’re like high-fives: A well-timed one is great, but too many can be annoying.

Never use exclamation points in failure messages or alerts.

Parenthesis

In standard sentences, avoid enclosing text in parentheses. It breaks up the sentence and can be hard to follow. Instead, try to rephrase the 
sentence or use commas for closely related material and dashes for less related material.

Use sparingly to refer to something as a side note. When addressing a phrase that could be singular or plural, always go for generic plural.
Say:  Select the contacts to remove.
Instead of:  Select the contact(s) to remove.

Enclose an expression, such as that is or namely, and the element it introduces in parentheses only if a comma doesn't signal a big enough 
break in continuity:

The task has been closed, that is, the Status field has a “Closed” value.
Users in a territory can be granted read, read/write, or owner-like access (that is, the ability to view, edit, transfer, and delete 
records) to the accounts in that territory.

Don't use parentheses within parentheses. Instead, rephrase; if necessary, change the second set to brackets.

Place semicolons and colons outside quotation marks and parentheses.

Place question marks or exclamation marks inside quotation marks, parentheses, or brackets only when they’re part of the quoted or 
parenthetical matter.

When parentheses or brackets enclose an independent sentence, place the period or comma inside. Otherwise, place the period or comma 
outside.

Periods

Be consistent. Use a period at the end of each list item, or don’t. Just don’t do both.

Using quotation marks? Put the period inside the closing mark. Example: Damon said, “I ate all the donuts.”

Periods go outside parentheses when the parenthetical is part of a larger sentence, and inside parentheses when the parenthetical stands 
alone.

Outside: I ate a donut (and I ate a bagel, too).
Inside:  (The donut satisfied my sweet tooth.)I ate a donut and a bagel. 

When abbreviating the time of day (which is always), use am and pm, lowercase without periods. And be sure to add a space after the digits.
Example: 8:30 am – 9 pm

Quotation marks

Only use for actual quotes, never for emphasis.

Terminology

See the Alexandria Library space  . Note ones tagged with "companion" are .Glossary company-wide terminology standards

Formatting
All relevant information on this page has been moved to . https://support.goalexandria.com/style-guide/

http://support.companioncorp.com/display/ALIB/Glossary
http://support.companioncorp.com/plugins/servlet/glossary/labels/search?label=companion
https://support.goalexandria.com/style-guide/
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a.  
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Page Structure 

Heading 1

Heading 2

Heading 5

Heading 4

Screenshot Guidelines

Dimensions: 1024 x 768 >> Makeover is 1366 x 768
Capture screenshots and present them on the page at their full-size.
Full-screen images should be resized to medium, about 533px. 
Avoid altering their size in an image editor—let Confluence do the shrinking (if required), because the user can always click the 
image to view its full size.

: Save screenshots in Format PNG format.

: Only use screenshots when you really need them as a "location anchor" for users, but not for every point in a series of steps. One Usage
main image is often sufficient to describe the functions of a specific page, but additional images should be included when necessary.

 When taking screenshots, omit any unnecessary detail. Only include the area of the page (or menu items) Only include necessary detail.
applicable to the context described in your documentation.

Screenshots should be centered, not indented (i.e. appear flush against the left of a page), unless they are part of Centered or indented: 
procedural steps, in which case, use Confluence's Ctrl+Enter feature to ensure they are indented to the correct step level.

 Use Preview or Snagit or annotations.Annotations:

Stock Images

Download: From our account on .https://www.istockphoto.com/
Store: Sync > Support Center > iStock pics folder.
Adjust 1: Run the image through Squash to compress the image. This saves space. Save it to the save folder, so you'll have an additional 
image with -squashed appended to the name.
Adjust 2: Open the squashed image in Preview and choose View > Adjust Size, and make it smaller (say, 1200px wide, which is plenty). 
This saves a lot MORE space.

Lists 

Only use numbered lists for step-by-step instructions. Separate steps into logical chunks, with no more than two related actions per step. 
When additional explanation or a screenshot is necessary, use a line break inside the list item.
Use bullet-point lists to indicate a range of choices or non-sequential items.
Lists should never go more than three layers deep.
If any item in a list (ordered or not) forms a complete sentence, all items must begin with a capital letter and end with a terminal punctuation 
mark.
If no items in an unordered list form a complete sentence, skip the capitalization and terminal punctuation.
If the items in the list complete an unfinished introductory sentence, end all but the last item with a semicolon, add an “and” before the final 
item, and finish off with terminal punctuation.

Links 

Cross Referencing
Visit the Microsoft Accessibility Website to learn more.
Link imperative sentences

Include a concise, contextual link whenever you’re referring to another page in Confluence or something on an external website. Do not link terminal 
punctuation. Prefer shorter links to long ones. Don’t include preceding articles (a, an, the, our) when you link text.

 Refer to No: our install guides for details.
 Refer to the Yes: Alexandria User Guide for details.

Check out our  article for more information.No: Administration Settings
 Check out  for more information.Yes: 7.17.7 Release Notes

https://www.istockphoto.com/
http://support.companioncorp.com/pages/createpage.action?spaceKey=ALEX&title=User+Guides
https://styleguide.mailchimp.com/web-elements/
http://support.companioncorp.com/pages/createpage.action?spaceKey=ALEX&title=User+Guides
http://support.companioncorp.com/display/ALEX/Administration+Settings
http://support.companioncorp.com/display/ALEX/7.17.7+Release+Notes


Cite knowledge base articles as follows:

: Read No this article for information on attachments.
: For more information No see Avatar attachments.
: For more information, see Yes Avatar attachments.

Don’t say things like “Click here!” or “Click for more information” or “Read this.” Write the sentence as you normally would and link relevant keywords.

Tabs

Brikit lets us have tabs on our pages. You can link to a specific tab by adding # plus the name of the article-Tabname, with no spaces.

e.g. http://support.companioncorp.com/display/ALEX/End-of-Year+Procedures
becomes http://support.companioncorp.com/display/ALEX/End-of-Year+Procedures#End-of-YearProcedures-Backups

Callout Boxes

Reading

Reading
Accessibility

Stay In Tech - UX Usability Checklist

Technical Documentation

Write The Docs - Documentation Principles (Guide)
24 Ways - The Construction of Instruction
24 Ways - Content Planning Demystified
24 Ways - Cooking Up Effective Technical Writing
24 Ways - Documentation Driven Design for APIs 
24 Ways - Kill It With Fire! What To Do With Those Dreaded 
FAQs

User Experience 

https://24ways.org/topics/ux/ 
24 Ways - How to do a UX Review
https://gathercontent.com/a-project-guide-to-ux-design-
download-pdf

Tip

Helpful tips or tidbits of information to help the user with their task.

Info

More information

Note

Informs users that failure to perform or avoid a specific action could result in a loss of data. For example: Activating a refreshed sandbox 
replaces the existing sandbox with the refreshed version. This permanently deletes the existing version and all data in it.

Warning

Informs users that failure to perform or avoid a specific action could result in a loss of data. For example: Activating a refreshed sandbox 
replaces the existing sandbox with the refreshed version. This permanently deletes the existing version and all data in it.

all relevant info has been moved to our Documentation Stylebook

http://community.secondlife.com/t5/English-Knowledge-Base/Avatar-attachments/ta-p/700031
http://community.secondlife.com/t5/English-Knowledge-Base/Avatar-attachments/ta-p/700031
http://community.secondlife.com/t5/English-Knowledge-Base/Avatar-attachments/ta-p/700031
http://support.companioncorp.com/display/ALEX/End-of-Year+Procedures
http://support.companioncorp.com/display/ALEX/End-of-Year+Procedures#End-of-YearProcedures-Backups
https://stayintech.com/UX
http://www.writethedocs.org/guide/writing/docs-principles/
https://24ways.org/2009/the-construction-of-instruction/
https://24ways.org/2012/content-planning-demystified/
https://24ways.org/2015/cooking-up-effective-technical-writing/
https://24ways.org/2010/documentation-driven-design-for-apis/
https://24ways.org/2013/what-to-do-with-faqs/
https://24ways.org/2013/what-to-do-with-faqs/
https://24ways.org/topics/ux/
https://24ways.org/2015/how-to-do-a-ux-review/
https://gathercontent.com/a-project-guide-to-ux-design-download-pdf
https://gathercontent.com/a-project-guide-to-ux-design-download-pdf
https://docs.google.com/document/d/1E62rvxe2DjSzxOtJISdT9lD_gbkurISkW9-ReCnWW2M/edit#heading=h.sip3sposnhyu


Vertical Lists 

https://www.copyediting.com/style-vertical-lists/ 
http://www.getitwriteonline.com/archive/101406VerticalLists.htm 

 

Desktop Apps
Windows

TechSmith Snagit

Screen capturing and annotation

Affinity Designer

Vector design and illustration
SVG editor
Can be used for wireframing
Licensed to mia@companioncorp.com

Adobe XD (free)

Wireframing tool

GIMP (free)

Find coordinates to create an image map.

iOS

Preview (free)

Screen capturing and annotation

Sketch

Wireframing tool
SVG editor

Adobe Illustrator

Vector design and illustration

How To - Macros
Create an image map

https://www.copyediting.com/style-vertical-lists/
http://www.getitwriteonline.com/archive/101406VerticalLists.htm
https://www.techsmith.com/screen-capture.html
https://affinity.serif.com/en-us/designer/
https://www.gimp.org/downloads/
https://www.sketchapp.com/
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